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1. SUMMARY

The study of the eukaryotic cell membrane lipid bilayer and its functionality is of paramount
importance to determine processes involved in signal transduction, transmembrane protein
activity, etc... Up until the 1980s, the fluid mosaic was commonly used to describe cell
membranes, but from there on the lipid raft model was proposed. According to the theory, the
lipid composition of bilayers is not homogenous, but rather microdomains rich in saturated lipids
and cholesterol which are more rigid and less permeable, and “float” in a liquid-disordered
phase, rich in unsaturated lipids. The aim of this report is to study the structure of lipid bilayers
with liquid phase segregation with both experimental and computational approaches. The
bilayers mimic the complex, lipid-raft based structure of in vivo membranes via the formation of
liquid phases in ternary vesicles.

Electroformation of lipid vesicles was carried out with three different compositions (DOPC,
DPPC/CHOL, DOPC/DPPC/CHOL), whose amount and diameter were quantified using optical
microscopy. DOPC vesicles are the smallest but most abundant, whereas DPPC/CHOL vesicles
are the least abundant but the biggest. Ternary vesicle lie between the two extreme cases.
Using fluorescence optical microscopy, liquid-ordered and disordered phases are observed, as
well as occasionally pear-shaped vesicles due to differences in surface tension

Coarse-grained molecular dynamics simulations in explicitly hydrated nanometric boxes with
periodic boundaries were carried out, at three different temperatures. DUPC was used as an
unsaturated lipid, as well as two different saturated lipids with different aliphatic chain length,
DLPC and DSPC and cholesterol. Liquid phase segregation was observed, as well as
anticorrelation phenomena between bilayer leaflets in DSPC-rich bilayers. Furthermore, the
lateral diffusion coefficient for each chemical species was calculated from the mean squared
displacement of the last part of each simulation and compared and contrasted with experimental
and other computational results to confirm they are realistic. DUPC is more mobile than their
saturated counterparts, which fits the lipid raft model previously discussed.
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2. RESUM

L'estudi de la bicapa lipidica de la membrana cellular eucariotica és de rellevant
importancia per determinar processos involucrats en la transduccié de senyals, I'activitat de
proteines transmembrana, etc... Fins els anys 80, el model del mosaic fluid era usat
comunament per descriure les membranes, perd es va proposar el model dels /ipid rafts.
Segons aquest model, la composicio lipidica de les bicapes no es homogénia, si no que es
formen microdominis rics en lipids saturats i colesterol, que son més rigids i impermeables, que
“floten” en una fase liquida desordenada, rica en lipids insaturats. L’objectiu d’aquest report és
estudiar la estructura de bicapes lipidiques amb separacié de fases liquides amb una
aproximacio tant experimental com computacional. Les bicapes a estudiar imiten la estructura
complexa i basada en lipid raft de les estructures in vivo de les membranes cel-lulars, per cami
de la formacié de fases liquides en vesicules ternaries.

La electroformacié de vesicules lipidiques es du a terme fent servir tres composicions
(DOPC, DPPC/CHOL, DOPC/DPPC/CHOL), la quantitat i diametre de les quals es quantifica
fent servir microscopia optica. Les vesicules de DOPC son les més petites i abundants, mentre
que les de DPPC/CHOL son les menys abundants perd més grans. Les vesicules ternaries
constitueixen un cas intermedi entre aquests extrems. Usant microscopia optica de
fluorescéncia, les fases ordenada i desordenada sén observables, aixi com vesicules amb
forma de pera a causa de diferéncies de tensié superficial.

Les simulacions de dinamica molecular coarse-grained es duen a terme en caixes
nanometriques explicitament hidratades, a tres temperatures diferents. DUPC es el lipid
insaturat escollit, aixi com dos lipids saturats amb diferent llargada de cadena alifatica, DLPC i
DSPC. S'observa segregacio de fases liquides, aixi com fendomens d'anticorrelacié entre capes
de la vesicula en bicapes riques en DSPC. A més a més, els coeficients de difusio lateral per
cada espécie quimica es calculen a partir del desplagament quadratic mitja de I'Gltima part de
cada simulacio, i es comparen i contrasten amb dades experimentals aixi com computacionals
per confirmar que sén valor realistes. DUPC és més mobil que els equivalents saturats, la qual
cosa s'ajusta al model de lipid rafts mencionat anteriorment.
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3. INTRODUCTION

3.1. CELL MEMBRANE AND LIPID RAFTS

Eukaryotic cell membranes, such as the ones humans possess, are mainly formed by a
liquid lipidic bilayer which is selectively permeable to apolar substances. The main components
of the bilayer are phospholipids, which are formed by a glycerol molecule bonded to two fatty
acids, as well as a phosphate group. Phospholipids are amphiphilic molecules, which constitute
a glycerol molecule bonded to two fatty acids and a phosphate group via ester bonds, with a
polar head and a longer apolar tail. The amphiphilic nature deeply affects the structure of the
bilayer: two layers of phospholipids with their apolar tails facing inwards, and their respective
polar heads facing the cytoplasm on one side and the extracellular matrix on the other (Figure
1).

Other components of the membrane are sphingolipids, glycolipids, cholesterol, proteins... It
constitutes the barrier between each cell and the rest of the body, and thus it is deeply involved
in regulating chemical pathways and reactions, as well as anchoring and communicating the cell
with its environment.

™

)

Figure 1. Transversal scheme of eukaryotic cell membrane. 1: Lg phase, 2: Lo phase, or lipid raft.

7:cholesterol

(Author: Artur Jan Fijatkowski, 24/05/2019 via Wikimedia Commons, Creative Commons Attribution)
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The composition and structure of cell membranes, however, is not homogenous. Up until
the 1980s, it was thought that proteins and lipids were distributed randomly, following the fluid
mosaic model. The existence of microdomains enriched with glycosphingolipids and sterols, and
with tighter packing and ordering, called lipid rafts, was first proposed [1]. As their name
indicates, and because of their tighter packing due to the action of the cholesterol over the
saturated aliphatic chains, denser microdomains that still retained liquid properties are formed,
and thus yielding coexisting liquid phases in a lamellar regime.

These phases are commonly known as liquid-ordered and liquid-disordered (shortened to Lo
and Lq, respectively). Furthermore, said lipid rafts can diffuse around the membrane, with fluidity
and might regulate not only the trafficking across the membrane, but also its activity [2], in
processes such as signal transduction [3]. For example, said regulation processes might be
involved in neurotransmission, and due to malfunction be also related to several nervous
system diseases [4].

The first inconvenient of this hypothesis, however, was that rafts are in the nanoscale, and
thus invisible to conventional optical microscopy, which led to skepticism about their existence
[5]. However, some alternatives for membrane lipid imaging have arisen, such as fluorescence
microscopy [6] or neutron scattering and diffraction in isotopically labeled membranes [7], which
have provided evidence for the existence of lipid rafts. Molecular dynamics computer
simulations have also been used to reproduce the spontaneous formation of two-phase lipidic
vesicles and their boundary dynamics at an atomic level [8], as well as protein distribution
across the membrane microdomains [9].

Due to the constraints of both time and resources, and because biological systems possess
a complexity that is hard to replicate and control in laboratory conditions, simplified lipid
vesicles, also known as liposomes, wil be used to carry out my experimentation. The lipid family
chosen is that of the phosphatidylcholines (PC), which as their name indicates, have a choline
group attached to the phosphate group. Specifically, DOPC will be used as an unsaturated lipid,
and DPPC and cholesterol to mimic lipid rafts, (Figure 2) and thus obtain Lo/Ls systems at a
bigger scale [10], using biologically coherent concentrations. The vesicles will be prepared via
electroformation in an ITO electroforming cell with oscillating alternate current [11].
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1 2 3

Figure 2: Components of electroformed lipid vesicles. 1: DOPC, 2: DPPC, 3: cholesterol

3.2. LATERAL SEGREGATION AND INTERLEAFLET CORRELATION

The experimentation can be complemented with MD simulations using GROMACS [12].
Molecular dynamics allows us to simulate numerically biological systems at very small space
and time scales. However, the time scale to resolve the calculations at an atomic scale greatly
exceeds that of the time allotted. For that reason, a specialized force field MARTINI has been
created [13], which provides a CG (coarse grained) model that greatly simplifies the calculation
of biological processes taking place at the microsecond scale.

The main objective of carrying out MD simulations is to “observe” phenomena that is not
visible at micrometric scale or using conventional optical microscopy, in order to complement
the experimental findings. Specifically, | would like to observe the same liquid lipidic domain
lateral segregation from a randomly generated lipidic bilayer with biologically coherent
composition, which would form Lo/Ls domains at the nanoscale, upon which the lipid rafts theory
is based on.

The driving force of this segregation is the lateral interaction between lipids and non-
complete miscibility between lipids. The most remarkable lateral interaction is cholesterol
causing a condensation effect amongst saturated lipids [14, 15], which results in an increase of
rigidity and a decrease of permeability, whilst maintaining bilayer fluidity. Cholesterol interacts
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more favorably with the straight, long aliphatic chains of saturated lipids, and allows for tighter
packing. That by itself doesn’t cause segregation, but when combined with unsaturated lipids
that do not show the same behavior due to tilted chains and less dense packing, segregation
occurs. There have been studies wherein lipid mixtures containing saturated lipids, unsatured
lipids and cholesterol where studied at different compositions with membrane models, ternary
diagrams where elaborated and coexistence of two liquid phases was found [10, 16].

| also expect to capture correlation and anticorrelation phenomena between the same kind
of liquid phase on either leaflet of the simulated membrane, depending on the chain length
difference between lipids on de Lo phase and the L4 phase. The two possible observable cases
are correlation between Lo domains on either leaflet of the bilayer, or anticorrelation between Lo
domains on either leaflet.

The biological relevance of these synchronization/desynchronization phenomena between
leaflets of lipid bilayers radicates from the effect it has beyond the mere structure in the case of
cell membranes, and in the realm of functionality of the actual membrane. Anticorrelation of
domains causes changes in the curvature of the membrane. lonic channels such as alamethicin
[17] and transmembrane proteins such as rhodopsin [18] are sensitive to spontaneous curvature
properties, which are dependent on lipid composition on their surroundings, and modulate their
activity via conformation change. In the case of rhodopsin, this conformation change acts as a
trigger of the visual excitation process. Similar behavior has been studied in phospholipases
[19].

Correlation between domains is also being studied as a regulator or inhibitor of signal
transduction through the membrane [20]. Furthermore, membrane proteins may not have the
same affinity for each liquid phase depending on their peptide sequence and their ternary
structure. Lipid shells that adhere to the surface of membrane proteins [21] or signals have been
proposed, that also affect the affinity of said molecules to either liquid phase.

To sum up, studying the behavior of lipid segregation and structure of liquid phase domains
in lipid bilayers might help understanding the whole of cell membrane functionality to a new
degree, beyond the proteins it contains and its basic separation function. The use of molecular
dynamics and computational means also eases the process of observing complex biological
systems and helps us predict and explore future developments.
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4. OBJECTIVES

The scope of this study is to characterize electroformed lipid vesicles with varying
composition and observe phase segregation in vitro, while complementing the study of lipid rafts
with MD simulations at different lipid compositions and temperatures of randomly generated lipid
membranes. The following are specific objectives

To successfully produce lipid vesicles with three different compositions (DOPC,
DPPC/CHOL and DOPC/DPPC/CHOL) using electroformation.

To characterize the number and size of the vesicles produced depending on their
composition.

To observe the liquid-ordered and disordered phases in ternary vesicles, which mimic the
lipid raft structure of in vivo membranes, using fluorescence microscopy.

To run MD dynamics simulations using a CG model and randomly generated bilayers to
observe phase segregation overtime.

To run MD dynamics with saturated lipids with different chain lengths and temperatures, and

observe possible phase morphology changes.

To extract qualitatively conclusions about the structure and stability of the vesicles prepared
from both the experimental and MD results.

5. METHODOLOGIES

In this next section of the report, | will address the experimental procedures carried out in
the lab and their specifics. These will include both the preparation of the lipid solutions, the
vesicles, and the observation protocols, as well as the steps necessary to carry out the MD
simulations.
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5.1 EXPERIMENTAL

5.1.1 Solutions and material procedures

Firstly, the solutions with the different mixtures of lipids must be prepared in their
correspondent biologically cohesive proportions. Three different kinds of solutions will be
prepared, which contain different types of lipids in variable concentrations. In all solutions,
however, the total concentration of lipids dissolved must not exceed 0.5 mg/mL, to ensure
complete solvating.

The first solution contains only DOPC (unsatured) at 0.5 mg/mL. The second one contains
DPPC (saturated) and cholesterol at 73:27 molar, because cholesterol is usually at around 30%
molar composition in human cell membranes. Finally, the third and last solution that is used will
be the one that resembles actual human cell membranes the most. It contains DOPC and
DPPC at around 1:1 molar relation, and around 30% molar of cholesterol as well, so | can
observe both the Ls and Lo phases present at once. The final molar relation between
DOPC/DPPC/Chol comes to 0.342:0.340:0.320. Furthermore, to differentiate the ordered and
disordered phases | use a fluorescent probe that tends to segregate completely to one of these
phases when the vesicles form. The probe selected is 14:0 NBD-DMPE, which tends to migrate
to the Lo phase, at around 2% w/w concentration.

The lipids are weighed while they are still frozen, to ease the procedure, in an analytical
balance with 5 decimals and dissolved in analytical grade chloroform. The mixture is stored in a
frosted neck glass vial, sealed with thread tape, inside a refrigerator. ITOs, like the rest of the
instrumental in the experimental procedures, must be managed and cleaned with and only with
ultrapure water, such as milliQ water, and micro90, as not to pollute the samples as well as not
to interfere with the efficiency of the electroforming process. Because the vesicles will be in a
solution, it is easier to build a platform to pour and contain said solution and observe it through
the microscope. For this purpose, DOWSIL 184 Silicone Elastomer Kit is used to prepare

silicone wells to contain the solution, of 5 x 5 mm.

5.1.2.Electroformation

The main objective of this step is to make the lipids interact with each other laterally, so they
start to arrange themselves to form bilayers. | do so by putting them in an aqueous but poor in
electrolytes medium between two conducting glasses connected to an oscillating, alternate
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current generator. By using a saccharose solution prepared with ultrapure water, | ensure the

electrolyte amount is minimal, and thus there is no current passing through the solution when

connected to the generator. Instead, only the potential oscillates, and so does the dipole at the

polar head of the PCs, due to the charges present (positive in the choline, negative in the

phosphate) in order to align itself with the electrical field. When in complete contact with water,

the aliphatic chain that interacted with the glass previously, is repulsed by the polar solvent, and

the lipids start to flip flop and arrange themselves in a more stable manner. Thus, the vesicles

are formed. This process is commonly known as electroformation [11]:

1.

Two clean, cut ITO glass slides are rinsed with water, and then dried with air. The
conducting side of the glass slide is found using a multimeter, with the auditory signal
mode, by pressing both electrodes on each side. The conducting side can be “seen” at
naked eye as well by finding the side of the glass that possess a slightly darker
coloration.

Two copper electrodes are then stuck with the metal part up, making sure that when
they are put them together, each one is touching the other glass slide. Double sided
adhesive tape is used.

Using wax, | form a noodle in a J shape to close off the area of one of the glasses that
will contain the solution with the lipids. The upper part of the J must be left outside.
Two drops of 5 L of lipid solution are dropped at the center of the area closed off by
the wax. The drops are let slowly, without separating the tip of the pipette from the
drop. The drops are next to each other, not overlapping, and | wait until the chloroform
dries completely.

The vial is once again covered with a frosted glass cap and sealed it with thread seal
tape. | make sure the lower part of the cap starts to dry once the tape is in place,
which indicates that the sealing is done. Store it again in the fridge until next use.

The ITOs are then put together, one in front of the other, and held in place with a
clamp in each side. Using a micropipette, around 400-500 L of a 200 mM aqueous
saccharose solution are put inside the area closed of by the wax and the glasses, until
a meniscus forms on top.

Carefully, and without letting any air bubbles come in, the upper part of the wax J
shape is brought down to cover the meniscus and seal off the contents of the
electroforming cell. If bubbles get in, and because of the amphiphilic character of the
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lipids, they will eventually migrate to the interphase between the air and the water, and
therefore the amount of vesicles formed will diminish drastically.

8. Once the cell is sealed, the current generator is set to 1 V and 2 Hz, and switched on.
The crocodile clamps are connected, one to each of the two cables connected to the
electrodes (Figure 3). The cell is left connected overnight, the average length of time is
usually around 16 hours.

9.  After this period has passed, and using a micropipette with the tip cut, in order to avoid
the new vesicles from passing through a tight space and be subjected to high pressure
that might break them, the contents of the cell are transferred to a 1 mL Eppendorf tub,
labeled, sealed with thread seal tape, and stored in fridge until further use.

10. The components of the cell are disassembled and dried. The wax is discarded and the
electrodes are stored in a box, as they can be reused after thorough cleaning with
basic solutions.

Figure 3: Connected electroformation cell

Now that vesicles have formed, | may proceed to characterize them using the microscope
by measuring and counting them. The vesicles must not be shaken violently to avoid bursting. It
is not recommended to preserve the vesicles for more than a week, because they might burst
overtime. However, some of the samples have been shown to last upwards 2 weeks with
minimal bursting, in the case of DPPC/Chol.
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5.1.3 Vesicle observation and characterization

In order to observe the vesicles, | first must prepare a silicon well that is joined to a glass
slide. A well is perforated all the way through using a punch extractor and a scalpel, conserving
the circular and flat shape of the walls. The textured side of the well is put on top of a glass
slide, with the channels in it horizontally. Using optical glue, | put some drops on the sides, and
wait. Due to capillarity, the channels will fill from each side and meet halfway.

Once all the channels are filled, use a UV lamp at 70% intensity and irradiate for 10 seconds
the glass slide until the glue solidifies. ALWAYS use UV-blocking glasses when operating the
lamp. The contents of the Eppendorf that contains the vesicles must not be stirred. Using a cut
100 pL micropipette tip, 60 WL of a solution containing vesicles are pipetted, and dropped slowly
in the center of the well. Make sure the tip and the drop maintain contact throughout the
process. Otherwise, vesicles may burst or move along the walls of the well, instead of most
remaining in the bulk.

Afterwards, 200mM glucose solution is added in the well with the same methodology, until a
meniscus forms on top. This step is key for the vesicles to settle and be visible later. Cover the
meniscus with a cover slip, making sure there are no bubbles underneath it. A good strategy is
to put it vertically at one side and drop it slowly from left to right. Finally, the vesicles are left to
settle at the bottom of the well for around 20-30 minutes, and the glass slide is then put under
the microscope for observation.

Depending on the vesicle type or composition, the ideal observation methodology will vary.
For DOPC, DPPC/Chol vesicles or ternary vesicles with no fluorescence, regular optical
microscopy can be used. Here follow the specifications used in the experimentation:

- Microscope: Nikon Eclipse 6400 Pol
- Camera: Pixelink PL-4741
- Augmenting lense: x20
- Scale: 100 ym - 300 px
- Lighting: minimal
- Filter: none or 6, depending on light conditions
- Capturing time: 10-40 ms
For ternary vesicles with fluorescence, an alternative source of light and filtering the correct

wavelength is needed, so the specifications are slightly different:
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Microscope: Nikon Eclipse 6400 Pol

Camera: Andor Ixon Ultra

Augmenting lense: x20

Scale: 100 pym - 125 px

Normal mode: 10 ms, no filter

Fluorescence mode: 6000 ms, no light, LED on with red filter. | also use a carton hood
to block most of the external light to enhance results. Increasing the exposure time will
highlight the richest in fluorescent probe and diminish the background noise, and vice

versa.

Phase contrast filters can also be used to enhance the contrast between vesicles and

medium, if necessary, depending on external lighting conditions.

The final step of this section helps characterize the size distribution and amount of vesicles

electroformed. This procedure can be done with a regular camera, for all vesicle types, granted

there is good contrast between the vesicles and the environment. First, | obtain the perimeters

of the vesicles formed:

1.

Using the capturing software, take 10 pictures around the center of the well. Photos
from the side of the well, due to interactions between the polymer and the vesicles,
are not as representative of the sample.

Open ImageJ, and then drag and drop the picture you will analyze.

Because the plugin cannot measure the radius of the vesicles, go to Analysis > Set
Measurements, and select both Area and Perimeter. Using commonplace formulas,
the radius can be calculated approximately from both properties.

Next, both brightness and contrast will be changed to make the vesicles stand out
more in the image. Go to Image > Adjust > Brightness/Contrast (shortcut
Ctrl+Shift+C), and then select Auto and Apply in that order.

Following this, the bandpass filter is used to illuminate the image equally, and
therefore facilitate the threshold selection step. Go to Process > FFT > Bandpass filter
and select OK.

Duplicate the image, because once the threshold is applied it cannot be modified from

the original image. Do so by pressing Ctrl+Shift+D.
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10.

1.

Now, select the threshold mode to highlight the borders of the vesicles. Go to Image >
Adjust > Threshold (shortcut: Cril+Shift+T) and select Auto. You can also modify it
slightly towards the right in the bottom slider, in order to highlight more vesicles, but
keep in mind it will also highlight more other parts of the image that might not be of
interest. If necessary, choose Process > Binary > Dilate

The vesicles will be detected and measured using a plugin. Go to Plugins >
Segmentation > DRAQS. The measured vesicles will appear highlighted in yellow and
numbered in the ROl manager pop-up. Delete all the selections that do not proceed or
are not correct using the ROI side bar, and then press shift and select the first and last
listing.

Click Measure, and another pop-up screen will show with the measurement. In order
to measure manually all the non-detected vesicles, select the oval brush tool from the
tool bar and hold Ctrl+Shift to draw a circle along the vesicle border.

Press Ctrl+M to add the measurement to the table. Click anywhere in the image
before measuring the next vesicle. If not, the measurements will be cumulative
instead of independent.

Once all the vesicles are measured, copy the information from the table on an Excel
spreadsheet. To repeat the process, close all windows except the one containing the

tool selection bar.

Then, | move on to analyze the data obtained. The median size, size distribution and

number of vesicles resulting from each lipid mixture undergoing electroformation is accounted

for using a histogram. The methodology is to be as consistent as possible when analyzing the

pictures. Pictures analyzed only belong to the center of the well, due to irregular and

misrepresentative distribution found along the edges of the well due to vesicles sticking,

bursting and decreasing in size. 10 images are taken in a grid-like manner in the center of the

well, making sure they have a similar number of vesicles in each one, regardless of their actual

sizes. Then, the images are analyzed using the previously mentioned methodology. In this case,

the perimeter is used to calculate the diameter of each vesicle in micrometers, presupposing

that they are spherical in shape. Afterwards, the data will be exhibited in a histogram, and the

average diameter of each type of vesicles is also calculated, to determine their relative size.
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5.2 COMPUTATIONAL METHODS

5.2.1 Coarse-graining approach

The MARTINI force field allows us to carry out MD simulations of simplified biological
systems [13] using a specifically parametrized bonding and non-bonding interactions, and
discretized interaction sites. This allows me to simulate faster than atom-by-atom simulations, at
the cost of some atomistic details. Bonding interaction are parametrized from all-atom
simulations, whereas non-bonding interactions are calculated using a Lennard-Jones 12-6
potential energy function with discretized strengths depending on the affinity or repulsion
between interaction centers [22].

The MARTINI force field is based on four-to-one mapping, in which four heavy atoms are
represented as a single interaction center, and each four-atom group is characterized,
parametrized and contrasted with experimental and thermodynamic data, and from there
classified in one of four main types based on the interaction type: polar (P), apolar (C), non-
polar (N), and charged (Q). Each type is then further characterized in several subtypes. For
example, depending on their hydrogen bonding type (d, a, da or 0), or their degree of relative
polarity if they are a P center (from 1 to 5, with 1 being the lowest). Lipids have four-to-one
mapping [23], whereas cholesterol requires less discretization due to its cyclic nature, and thus
uses three-to-one mapping [24].

For the MD of two-phase vesicles, | use the insane program [25] to generate a box system
with the desired lipidic proportions already in a bilayer structure, with random distribution and
hydration. From there, and with the file containing the topology of the molecules involved, the
simulation is run using the GROMACS MD package [12]. In short, GROMACS first calculates
the potential energy of all interaction centers using the parameters provided by MARTINI force
field, distinguishing between intra (bond, angle, torsions...) and intermolecular (electrostatic,
Van der Waals forces...) interactions. Then, it solves the derivate of the potential energy to
obtain the forces, and then finally solves Newton’s motion equations for the predetermined time
step. This process is repeated with the previously obtained coordinates until all time steps are
done. The final result of the simulation is a trajectory which contains the evolution of the system
overtime. Longer systems and timescales, therefore, involve longer calculation times. The
trajectory data can also be analyzed to obtain further information about the system, such as
area per lipid, bilayer thickness, lateral diffusion rates, efc...
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5.2.2 Simulated molecules

As previously mentioned, the insane program will be used to generate lipidic bilayers with
known composition and random distribution. The molar concentrations will be similar to the ones
used in experimental conditions, 1:1:0.3 for saturated, unsaturated and cholesterol respectively.
In this batch of simulations, DUPC will be the unsaturated PC, while there will be two saturated
PC types: DSPC and DLPC (Figure 4). DLPC has a shorter chain length than DSPC, and when
applying CG modeling, that translates to two less interaction centers in four-to-one mapping.
DUPC also has one more unsaturation than DOPC.

1 2 3 4
Figure 4: Simulated molecules: 1: DLPC, 2: DSPC, 3: DUPC, 4: cholesterol. Colored circles show
MARTINI mapping

This is done to speed up the calculations and will come into play in the study of the liquid
phases’ morphology change. Water molecules are explicit and simulated as well, but their
quantity in the box is regulated by the insane program depending of the hydration needed. In
Figure 4, it can be seen that the aliphatic chains of the lipids have C1 interaction centers, with
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represent the highest degree of apolarity, and the unsatured centers have a C4 type interaction,
which is less apolar. The choline group has a QO type center, which represents that it is charged
but does not act as a donor or acceptor of hydrogen bonds. The phosphate group is Q type, but
has a subtype, because it can accept hydrogen in a hydrogen bond. As was commented on
before, cholesterol shows a higher discretion level for mapping.

5.2.3 Simulation protocols

Insane program provides the initial coordinates for the simulation, while the top file provides
the topology of the molecules, as well as calling the itp files that contain both the force field
parameters and charges. Energy minimization is first carried out using the steepest descent
mode, before the MD simulation proper. Energy minimization detects unfavorable overlaps and
interactions and corrects them to avoid crashes and longer simulation times. MD simulation can
only be done after this minimization step. MD simulation is carried out in the IQTCUB computer
cluster, due to its highly demanding CPU time and capabilities.

All simulations have the same time step of 0.01 fs. They also have the same cubic box size
of 20 nm, with periodic boundary conditions. This last condition means that, when calculating
energies, forces and movement, GROMACS will consider that in the adjoining directions of the
simulation box in all axes, lie multiple versions of the same box, which makes it slightly similar to
real conditions. Temperature and pressure coupling are also implemented. This option allows
the box to, after a set period of time, check if there have been changes in these conditions and
rectify them to previously set values by slightly modifying energies, speed, etc... in order to
maintain conditions similar to that of an isothermal bath, in the case of temperature.
Furthermore, pressure is stablished as a semisotropic constant in all simulations. This means
that constant pressure of 1 bar is applied in the perpendicular axis to that of the bilayer plane,
as well as in the xy parallel plane that contains the bilayer itself. However, these pressures are
coupled independently from each other. AT, or the recalculating step taken for the coupling, is of
1.5 ps for temperature and 3.0 ps for pressure. A cut-off distance of 1.2 ns for Van der Waals
interactions is also implemented for all simulations.

Simulation length is the same for all systems: 1800 ns. However, it can be lengthened by
600 ns if a certain phase equilibrium is not reached, for example in the case of the bilayer
containing DSPC at 295K. The trajectories and final state of the simulated systems are
visualized and analyzed using VMD, which also allows us to visualize different chemical species
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independently, represent energy surfaces, etc... The MSD for all chemical species is also
computed, from a provided initial position of a trajectory. Specifically | use the last 600 ns of
each simulation, once phase segregation is reached, and through these values the lateral
diffusion coefficient of the phases is obtained.

6. RESULTS

In this following section of the work, | discuss the results of the experimentation. Firstly, |
discuss the results of the first half of the work, which corresponds to experimental vesicle
formation and characterization. Later, the results of the MD simulations, leaflet correlation
phenomena and calculated lateral diffusion coefficients will be discussed.

6.1 Experimental results

Vesicles with three starkly different lipid compositions have been successfully prepared via
electroformation in a reproducible manner, with vesicle amounts enough to allow systematic
vesicle recount and measurement via image analysis. The three kinds of vesicles prepared are
DOPC (unsatured), DPPC/CHOL (saturated, 1:1 molar) and ternary vesicles containing
DOPC/DPPC/CHOL (0.342:0.340:0.320 molar), mimicking the composition of eukaryotic cell
membranes. Ternary vesicles also contain a fluorescent probe that has higher affinity with the
Lo phase, and therefore will be shown with light coloration in fluorescence optical microscopy,
with their Ld counterparts remaining dark.
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After analyzing the images obtained using Image J, with the DRAQ5 plugin, and treating the
data to obtain average diameters as well as size distribution histograms, the following results
were obtained. First, almost vesicles are spherical in shape, due to the lowering of the surface
area to volume ratio effect on the stability of the vesicles. Their size ranges between 5 to 70 pm,
depending on the composition, with 10-20 um being the most common size bracket (Figure 8).
None of the vesicle types possess Gaussian size distribution. In Figure 5a, DOPC vesicles are
observed, which are abundant but smaller in size, compared to their DPPC/CHOL counterparts
(Figure 5b, Table 1). DPPC/CHOL have lower curvature due to the rigidity added by cholesterol,
and thus can be bigger.

Figure 5: images of vesicles taken with Andor Ixon Ultra. A: DOPC, B: DPPC/CHOL

Ternary vesicles lie between these two extreme cases (Figure 6a), forming in lesser
quantities but still slightly bigger than DOPC vesicles (Table 1). Cholesterol acts as the driving
force behind phase segregation, as | previously mentioned in section 3.1, due to the
condensation effect they cause in saturated lipids.

When they are put under fluorescence optical microscopy (Figure 6b), not all the vesicles
present in Figure 6a show up, meaning they are entirely made up of L4 phase, and some
vesicles are entirely lighted, which means they contain only Lo phase. However, vesicles with
only half or part of the vesicle is Lo phase, which is lighted, and the rest is Lo are present in the
sample. Therefore, phase segregation is actually observed experimentally.

Only ternary vesicles occasionally also show a pear-like shape (Figure 7), which is caused
by the difference in surface tension between the liquid-ordered and disordered phases, showing
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as two different curvatures in the same vesicle. The “bright” phase corresponds to the Lo phase,
where the probe is located. Lo phase tends to display lower curvatures than the Lq phase, due to
the rigidity provided by the presence of cholesterol and tighter packing.

Figure 6: images of ternary vesicles taken with Andor Ixon Ultra. A: regular lighting, B: fluorescence.

[lluminated areas correspond to Lo phase

Figure 7: pear shaped terary vesicle, taken with Andor Ixon Ultra
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Entry Vesicle type Average diameter [um] c:se;iﬁ:;é Total vesicles
1 DOPC 14,67 218 1887
2 DPPC/CHOL 22 30 295
3 DOPC/DPPC/CHOL 15,77 51 465

Table 1: electroformed vesicles characterization data
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Figure 8: Vesicle diameter histogram with relative frequencies

6.2 Computational results

Simulations were run using the MARTINI CG force field and GROMACS of three cubic
20x20x20 nm boxes with periodic boundaries, with the same parameters and simulation length
(1800 ns), but at three different fixed temperatures (285K, 290K, 295K) using an isothermal
conditions. Half of the simulations have been done using DLPC (3 interaction sites in the
aliphatic chain, see Figure 4.1), and the other half DSPC (which has a longer aliphatic chain,
with 5 interaction sites, see Figure 4.2), as the saturated lipid, and cholesterol at biologically
coherent concentration, giving us 1:1:0.3 molar concentration respectively. Trajectories and

membrane images are obtained using VMD.
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v

1200 ns 1800 ns

Figure 9: phase segregation sequence of DLPC containing bilayer at 285 K. Liquid phase formation can be

observed. DLPC: yellow, main component of L, phase

DSPC/DUPC/CHOL

a) T=285K ) T=290K ¢)T=205K

Figure 10: Domain fluctuation and shape depending on temperature for a same composition.
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DLPC/DUPC/CHOL 285K DSPC/DUPC/CHOL 290K

Figure 11: final states of simulations. a,b and d,e show either leaflet of the respective bilayer. ¢ and f show
the profiles. DLPC containing bilayer shows correlation, whereas the DSPC containing one shows

anticorrelation.

In all cases, segregation between Lo and L4 is observed (an example of this process is
Figure 9), and this segregation is generally slower at higher temperature. Furthermore, there are
less fluctuating and rounded domains at lower temperatures, when the system has deeper
quenching (Figure 10a). This is likely due to less thermally-related Brownian movement, and
because the deeper the quenching, the more segregated and enriched with their respective
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lipids the domains are and larger lineal tension. In Figure 11, the final conditions of simulations
for both DLPC and DSPC containing bilayers can be seen. On the left, the domains on both
sides (Fig. 11a,b) are more rounded and there is correlation between leaflets, which is more
noticeable when looking at the side view (Fig. 11c).

Lateral phase separation is proposed to be entropy drive to keep the disordered unsaturated
lipids away from the rafts, where they cannot be incorporated due to tight packing and
cholesterol condensation effect [26]. Appearance of a stripped pattern in domains is attributed to
the finite size box effect due to the use of periodic boundaries (Figure 11d,e) [8].

DLPC-enriched L, domains generally show correlation of domains on both sides of the
membrane, whereas DSPC-enriched Lo domains show anticorrelation (Figure 11f).
Furthermore, anticorrelated domains show more warping in the bilayer than correlated domains.
This can be attributed to the fact that, although lipid self-assembly allows lipids to interact
attractively with each other for the most part, there is also repulsive interaction due to surface
tension in domain borders as well as with the hydration water and the opposing bilayer on the
surface of the domains. For example, the following figure (Figure 12) contains three distinctly
different situations. Figure 12a displays a cross section of a DLPC-L, phase in DUPC-Lg. Due to
the fact that their aliphatic chains have similar lengths, so they can be stacked onto each other
without attached difficulty. In this case, only lineal tension between domains is relevant. At the
nanoscale, the lineal tension due to perimeter surface of the domain is still a major contributing
factor to the overall tension.

a) b) c)
|
| 1
B ourc

DLPC
DSPC

Figure 12: schemes of correlation and anticorrelation phenomena between leaflets in lipid bilayers. Red

lines show unfavorable lipid-water lineal tension
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With DLPC, the side chains in both saturated and unsaturated lipids are of similar length,
and thus synchronization between L, domains on both sides occurs. However, with the case of
DSPC (Figure 12b), which has a longer chain, saturated lipids would protrude from the surface
of the membrane on both sides, and thus increase the lineal tension of the domain perimeter
because of contact with the surrounding aqueous environment, which is energetically very
costly. This situation, which is not displayed when using DLPC, is therefore highly unstable.

For this reason, the leaflets may shift parallelly and desynchronized on either side, showing
anticorrelation (Figure 12c), in order to decrease the linear tension between the Lo perimeter
and the aqueous surroundings. While this also increases the interleaflet surface tension, this
effect is only noticeable at bigger scale. This can be seen in the computational results,
specifically in Figure 11f.

Therefore, the PC lipid used not only influences the organization of lipids within the leaflet, it
also influences organization and structure between leaflets, which can have repercussion in
membrane functionality [17-21]. On another note, at nanometric scale, the surface tension of a
domain can be considered constant, but as the domain grows, surface tension experiences
quadratic growth, and thus the domains might resynchronize at micrometric scale when it can
compensate the linear tension with water.

To further analyze the results, GROMACS is also used to calculate the mean square
displacement of each chemical species during the last 600 ns of simulation and the first frame
as the reference. Only Brownian movement is considered, and movement restrained to the xy
plane, where the bilayer is located. However, because | am working with periodic boundaries, if
MSD were to be calculated indefinitely, a maximum would be reached. Therefore, if said
maximum appears in the graph, the time frame is truncated to avoid it. The graphics obtained
(Figure 13, Appendix 1) show that there is a lineal relation between time and MSD. This fits with
the following model for liquid diffusion, where d stands for the dimensionality, and D the
diffusion coefficient- Therefore, if regression for the data is done, and the slope is divided by
four, the lateral diffusion coefficient is obtained (Table 2).

< Ar? >=2dDt

In general, the results fit with experimental [26-28] and computational [8] data consulted,
which puts them at around 10-"-10-8 cm?/s; and thus, can be considered realistic. It is possible to
confirm that there are two liquid phases, and that DUPC in general has bigger diffusion
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coefficient than DLPC or DSPC, and thus higher mobility and fluidity. This correlates with the
lipid raft model, because these are more rigid and “float” around the Lo phase.

DUPC/DSPC/CHOL 295K

1,4E-12
1,2E-12
1E-12
8E-13
6E-13
4E-13
2E-13
0
0,00E+00 1,00E-07 2,00E-07 3,00E-07 4,00E-07

Time(s)

MSD (cm”2)

——DSPC ——DUPC CHOL

Figure 13: MSD graphic example, for DSPC-enriched bilayer at 295K during the last 600 ns of the CG MD

simulation

D lateral (107cm?/s)

Entry Lipid 295K
1 DLPC 5,81
2 DUPC 6,66
3 CHOL 6,89

Entry Lipid 295K
5 DSPC 6,15
6 DUPC 7,59
7 CHOL 7,22

Table 2: Lateral diffusion coefficients from CG MD simulations at 295 K



30 Cardenal Rodriguez, Anna

7. CONCLUSIONS

Lipid vesicles with three different compositons (DOPC, DPPC/CHOL, and
DOPC/DPPC/CHOL 0.342:0340:0.320 molar, which mimic and simplify the structure of cell
membranes, were successfully prepared via electroformation.

Vesicles were found to be generally spherical, and between 5 and 70 ym in diameter, with
10-20 ym being the most common bracket. DOPC vesicles were the smallest and most
abundant, whereas DPPC/CHOL were the biggest but in less quantity. The latter is likely due to
the increase of curvature and rigidity caused by cholesterol condensation and tighter packing.

Ternary vesicles lie between the two extreme cases. Using fluorescence microscopy, it is
possible to distinguish between the micrometric Lo and Lq phases. Furthermore, some vesicles
show pear-like shape due to the coexistence of two different surface tensions for each
microdomain, and thus two different curvatures.

CG MD simulations using GROMACS for a DOPC/saturated lipid/CHOL 0.33:0.33:0.33
cubic 20x20x20 nm sized explicitly hydrated box with periodic boundaries were carried out at
three different temperatures (285K, 290K, 295K). Two different kinds of saturated lipids were
used: DLPC, which has a shorter aliphatic chain, and DSPC, which has a longer one.

In all simulations, liquid phase segregation was observed at the nanometric scale, with Lo
and Lq phases forming, which are akin to the lipid rafts model found in in-vivo membranes.
Quenched systems, or systems are lower temperatures, show less fluctuation and less irregular
Lo domains than systems at higher temperature.

In systems containing DLPC, correlation between domains on either side of bilayer was
observed, whereas in DSPC-containing systems, anticorrelation between domains was
observed as well as bilayer warping and bending as a result of said anticorrelation. This
anticorrelation is said to have a key role in regulating membrane functionality.

Secondly, the mean square displacement in the bilayer plane for the last 600 ns of each
simulation is calculated and graphed for each chemical species. The relationship between time
and mean square displacement is lineal, and within realistic magnitude, and thus it can be
confirmed that liquid phases have been formed.
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From this information the lateral diffusion coefficients can be obtained, and it was
determined that unsaturated lipids of the Lo phase have higher diffusion than saturated lipids,
analogous to the tighter packing in lipid rafts that makes them more rigid and less mobile.

To sum up, the final conclusion is that the PC type not only determines organization in the
membrane on the same leaflet, but also between leaflets, in liquid phase segregated lipid
bilayers.
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9. ACRONYMS

CG: Coarse grained

Chol: cholesterol

DLPC: 1,2-dilauroyl-sn-glycero-3-phosphocholine

DOPC: 1,2-dioleoyl-sn-glycero-3-phosphocholine

DPPC: 1,2-dipalmitoyl-sn-glycero-3-phosphocholine
DSPC: 1,2-distearoyl-sn-glycero-3-phosphocholine
DUPC: 1,2-dilinoleyl-sn-glycero-3-phosphocoline
GROMACS: Groningen Machine for Chemical Simulations
ITO: indium tin oxide

LED: light emitting diode

Lo: liquid-ordered phase

Ld: liquid-disordered phase

MARTINI: CG force field for biomolecules and simplified biological systems

14:0 NBD-DMPE:  1,2-dimyristoyl-sn-glycero-3-phosphoethanolamine-N-(7-nitro-2-1,3-
benzoxadiazol-4-yl) (ammonium salt)

MSD: mean square displacement
OM: optical microscopy
PC: phosphatidylcholines

VMD: Visual Molecular Dynamics
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APPENDIX 1: MEAN SQUARED DISPLACEMENT GRAPHICS
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